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Overview
AMIBCP stands for American Megatrends BIOS Configuration Program. It provides you, the 
OEM or system integrator, with an easy way to customize some of the AMIBIOS features 
without coding. This means that you do not have to contact American Megatrends every time a 
minor change has to be made in your system’s AMIBIOS.
With AMIBCP, you can customize your AMIBIOS. This can speedup system development and 
allow you a greater degree of freedom in adding or changing system features.

Features
This utility offers following features: 

• Configure the AMIBIOS System Setup.
• Edit the Registers Tables.
• Edit PCI IRQ Routing Table.
• View AMIBIOS Features, CPU Microcode Patches, Edit Minor Version Number, Sign on 

message and OEM data.
• View and Edit AMIBIOS String.
• View and Modify AMIBIOS DMI Tables.
• SETUP screen layout 

Requirements
Supported Operating System

AMIBCP Utility is supported in the following operating systems:

• Microsoft® Windows® 98 (v3.30 and above will not support any more.)
• Microsoft® Windows® ME
• Microsoft® Windows® NT 4.0
• Microsoft® Windows® 2000
• Microsoft® Windows® XP/XP64
• Microsoft® Windows® PE
• Microsoft® Windows® Vista 32/64

BIOS Requirements 
The loaded BIOS ROM file should have the followings:

• The file MUST be an AMIBIOS ROM file (Core version 8.xx.xx only)
• BIOS ROM file should be building via “8.00.08_AMITOOLS_17” label or above.

Getting Started
Installation 
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Copies the AMIBCP.EXE executable file to any storage location accessible by the host  
system and then double-click AMIBCP icon Or type AMIBCP in command prompt to  
run.

Main Window

Menu Bar
The Menu bar is located at the top of the AMIBCP window. The Menu bar contains the 
following:

• File drop-down menu
• View drop-down menu
• Window drop-down menu. This menu can be shown only when BIOS ROM loaded.
• About

File drop-down menu
When you click on File, the File menu drops down as shown in the following:

Copyright 2008 NDA Required (NDA) Page 4 of 20



American Megatrends, Inc.
AMIBIOS8 Utility User Guide

The File drop down menu item are explained in the following table:
File menu item list

Name Description
Open Open an AMIBIOS ROM file.
Save Save any changes you have made to the AMIBIOS ROM file.

Save As Same feature as Save item. In addition, it allows you to specify the 
location and change the existing file name.

Report Generate a report for current AMIBIOS ROM file. All of the BIOS 
information will write to specific path/filename.

Exit Quit program.

View drop-down menu
When you click on View, the View menu drops down as shown in the following:

The View drop down menu item are explained in the following table:
View menu item list

Name Description
Toolbar Display or hide the Toolbar. The Toolbar is displayed under the Menu 
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bar.

Status Bar Display or hide the Status bar. The Status Bar is displayed at the bottom 
of the AMIBCP window.

Window drop-down menu
When you click on Window, the Window menu drops down as shown in the followings:

The Window drop down menu item are explained in the following table:
Window menu item list

Name Description
New Window Open current AMIBIOS ROM to a new window.

Cascade Arrange the AMIBIOS ROM windows so that they overlap one 
another.

Title Display AMIBIOS ROM windows at the same time.
Arrange Icons Automatically arrange the icons.

About
When you click on About, AMIBCP copyrights information will be shown as below:
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Toolbar
The Toolbar is located under the Menu bar. It contains three icons.

The Toolbar icons are explained in the following table:
Toolbat Icon List

Icon Description

Open an AMIBIOS ROM file.

Save any changes you have made to the AMIBIOS ROM file.

Display AMIBCP copyrights information.

Body Frame
The Body Frame is the main frame of AMIBCP. It is located under the Menu bar and 
Toolbar. The AMIBCP main functions are displayed in the body frame screen.

Status Bar
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The Status bar is located under Body Frame. The left area of the Status Bar describes 
actions of menu items as you use the arrow keys to navigate through menus. The right 
area of the Status Bar indicates if any of the following keys are latched:

Item Description
CAP The <Caps Lock> key is latched down.
NUM The <Num Lock> key is latched down.
SCRL The <Scroll Lock> key is latched down.

Functions
To use AMIBCP, you can double-click the executable file icon to open Main Window and press 
on Toolbar to open an AMIBIOS ROM file.
AMIBCP allows you to view and modify the AMIBIOS ROM file image. You can perform 
various actions using the following configuration tabs:

• Setup Configuration Tab
• Register Editing Tab
• PCI IRQ Routing Tab
• BIOS Features Tab
• BIOS Strings Tab
• DMI Tables Tab 
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Setup Configuration Tab
The Setup Configuration tab allows you to change the settings for AMIBIOS setup 
options.To change settings, just double-click on the field/check box what you want to 
do. Currently, you can perform the following actions:

• Edit the control group structure names
• Show or hide setup screen and setup questions
• Modify access levels and usage
• Edit failsafe and optimal values
• Change SETUP screen layout

An example of the Setup Configuration tab is shown below:

Field
The Setup Configuration fields are explained in the following table:
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Field Description

Handle This field displays the setup item’s string number in BIOS strings. 
This is a read-only field.

Control Group 
Structures

This field allows you to modify the setup item’s name that appears 
in the AMIBIOS setup screen.

Show This field allows you to display or hide a particular setup item from 
the AMIBIOS setup screen.

Access/Use This field allows you to control the access levels and usage of setup 
item.

Failsafe This field allows you to program the setup item with the safest 
possible settings that can be used if the system behaves erratically.

Optimal This field allows you to program the setup item with the best system 
performance settings.

Buttons
The Setup Configuration button is explained in the following table:

Icon Description
This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

Menu Help String

This area displays the help string for individual setup menu. When you select a 
menu item on Setup Menu list, the help message will be shown here:

Control Help String

This area displays the help string for individual setup item. When you select an 
item on Control Group Structures list, the help message will be shown here.

Setup Structures 

The Setup Structures consists of setup controls, such as questions, date, time, 
password, and setup control group items.
Example of Setup Structures are shown in the following table:

Field/Check Box Description
Setup Controls For setup questions, you can modify the show, access/use, failsafe 
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and optimal fields. Setup questions strings can be edited.
For the date, time and password controls, you can modify the show 
and access/use fields.
Note: Setup question strings can be edited or replaced in the BIOS 
Strings tab.

Control Group 
Items

For the separator control group item, you can modify the show 
field and type of separator to display (blank line/single, thin 
line/double or thick line).
For the static-text control group item, you can modify the show 
field and usage (normal/title).
For the dynamic-text control group item, you can modify the show 
field and refresh on/off value of the dynamic text (refresh or no 
refresh). 
Note: If the refresh option is selected, the text refreshes once per 
second.

Using the Setup Configuration Tab

You can use the Setup Configuration tab by following steps:
1. Select a setup screen and a sub setup screen.

For example : Advanced->Super IO Configuration
Note : Some of the setup screen does not have sub setup screen.

2. Click on Show, Access level, Fail-safe or Optional fields to modify setup 
options.
Note : When modifying Failsafe/Optional fields, some items have only list of 
numbers. These items are implemented using AMIBIOS external functions. Its 
required executing AMIBIOS code is used to define the list of all possible 
options for setup items. These fields are filled with numeric identifiers because 
external functions are not available after booting.

3. To save the changes you have made to the AMIBIOS ROM file, click on the 
File menu bar and select Save menu item. You can also click icon on Toolbar 
to save the changes you have made.
Note : You can click on the Undo button to restore the original setup settings 
before saving any new changes.

Changing SETUP screen layout in Setup Configuration Tab

You can change SETUP screen layout in Setup Configuration tab by following 
steps:

• Menu Item layout
1. Choose a Menu Item you want to move on left side of Setup 

Configuration tab.
2. Click and hold on left button of mouse.
3. Drop the chosen Menu Item to new place.

While the dropping operation is under running, you may see following 
icons:
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Icon Description

This icon indicates the chosen Menu Item will be subordinate to the 
focus item.

This icon indicates the chosen Menu Item will be having same rank 
with the focus item.

This icon indicates the chosen Menu Item may not move to the 
place where you like.

• Question Item layout in same Menu
1. Choose a Menu Item on left side of Setup Configuration tab.
2. Choose a Question Item you want to move on right side of Setup 

Configuration tab.
3. Click and hold on left button of mouse.
4. Drop the chosen Question Item to new place.

• Question Item layout between Menus
1. Choose a Menu Item on left side of Setup Configuration tab.
2. Choose a Question Item you want to move on right side of Setup 

Configuration tab.
3. Click right button of mouse to Cut the target Question Item.
4. Choose the Menu Item you like on left side of Setup Configuration tab.
5. Click right button of mouse on right side of Setup Configuration tab to 

Paste the cut Question Item.

Register Edit Tab
The Register Edit tab allows you to edit the AMIBIOS register tables. Each table 
contains register, data, or other fields that can be edited.
Note: Depending on a particular BIOS table, more than two columns can be used.
An example of the Register Edit tab is shown below:
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Field
The Register Edit fields are explained in the following table:

Field Description

Register This field allows you to change the register address of a particular 
device or chipset.

Data This field allows you to change the values to be programmed into 
the device or chipset.

Undo This button allows you to restore the original register values.

Buttons
The Register Edit button is explained in the following table:

Icon Description
This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

Note : It is not recommended to change chipset registers values without working knowledge 
about that specific chipset.

Using the Register Edit Tab
You can use the Register Edit tab by following steps:

1. Click on the Register table to be edited from the list of that appear on the left 
side of screen. A list of register values or other data is displayed on the right 
side of the Register Edit tab screen.

2. To edit the fields, simply double-click on the field you want to modify and type 
in new value.

3. To save the changes you have made to the AMIBIOS ROM file, click on the 
File menu bar and select Save menu item. You can also click icon on Toolbar 
to save the changes you have made.
Note : You can lick on the Undo button to restore the original setup settings 
before saving any new changes. 

PCI IRQ Routing Tab
The PCI IRQ Routing tab allows you to view and modify the PCI IRQ Routing table 
that is used by AMIBIOS during POST and runtime.
You can view and modify the following fields: 

• PCI Bus
• Dev.#
• Int A-B-C-D Reg
• Int A-B-C-D Bitmap
• Phys.Slot

An example of the PCI Routing tab is shown below:
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Fields 
The PCI IRQ Routing fields are explained in the following table:

Field Description

PCI Bus
This field displays the PCI bus that the device/slot is on.
Note: Most boards contain a single PCI bus, so this field is usually 
set to 0.

Dev.#

This field displays the PCI device/slot number.
The value of this field is set to a slot or device address on the PCI 
bus shifted left by three bits (the device number must be in bits 7:3 
and bits 2:0 must be 000).

Int A-B-C-D Reg

This field displays the chipset register number that controls the PCI 
slots (or device) Int A, B, C, and D Pin. The value in this field is 
basically arbitrary. Slots and devices that share the same chipset 
interrupt signal must have the same value for this field. 
For example: 
If Slot 1 Int A pin and Slot 2 Int B pin are both connected to the 
same chipset interrupt signal, then the chipset register value for 
Slot 1 Int A must match Slot 2 Int B. 
If a slot or device has nothing connected to its Int A pin, then this 
field must be set to 0. 
If a slot or device has its Int A pin hardwired directly to an IRQ, 
then this field is set to 0Fxh (where x is 0-F for IRQ 0 - IRQ 15). 
This is useful if a motherboard has a PCI IDE chip that has its Int A 
pin hardwired to IRQ 14.

Int A-B-C-D 
Bitmap

This field displays the IRQ that the chipset is capable of routing to 
in the slots (or device) Int A, B, C, and D pin. 
Note: If the value for Chipset Register is set to 0, then all bits in 
this field are set to 0. 
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Note : If the value for chipset register was set to 0Fxh to indicate a 
hardwired connection to a certain IRQ, then only one bit 
corresponding to that IRQ must be set in this field.

Phys.Slot

This field displays the slot number of a PCI slot as it appears to the 
end user. Numbers like 1, 2, 3, and 4 must be used. 
Note : Onboard PCI devices such as PCI IDE chips must have this 
field set to 0 to indicate that the device is not a removable PCI 
adapter card.

Buttons
The PCI IRQ Routing button is explained in the following table:

Icon Description
This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

Using the PCI IRQ Routing Tab
You can use the PCI IRQ Routing tab by following steps:

1. To modify any field in the PCI IRQ Routing table, simply double-click on any 
field you want to modify and type in new value.
Note : You can add a new PCI entry into the table if all fields in the entry are set 
to zeros.

2. To save the changes you have made to the AMIBIOS ROM file, click on the 
File menu bar and select Save menu item. You can also click icon on Toolbar 
to save the changes you have made.
Note : You can click on the Undo button to restore the original setup settings 
before saving any new changes.

BIOS String Tab
The BIOS Strings tab allows you to view and edit AMIBIOS strings.
An example of the BIOS Strings tab is shown as below:
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Fields
The BIOS String fields are explained in the following table:

Field Description

Token The Token field displays the string handle that is used by 
AMIBIOS to reference the string.

String The String field displays the AMIBIOS sreing as it appears in the 
AMIBIOS setup or POST screen. This field is editable.

Find String This field allows you to find a specific string in BIOS Strings list. 
The string is case-insensitive.

Buttons
The BIOS String button is explained in the following table:

Icon Description
This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

This button allows you to find next string in BIOS Strings list.

Using the BIOS String Tab
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You can use the BIOS String tab by following steps:
1. To modify any string, double-click on it and type in the new string.
2. To save the changes you have made to the AMIBIOS ROM file, click on the 

File menu bar and select Save menu item. You can also click icon on Toolbar 
to save the changes you have made.
Note : You can click on the Undo button to restore the original setup settings 
before saving any new changes.

BIOS String Tab
The BIOS Features tab allows you to view and configure some of the AMIBIOS 
features.
You can view the following fields:

• BIOS Date
• BIOS Name
• Processor
• Major Version
• ID String 1
• BIOS Size
• Reference Number
• CPU Microcode Update Patchs
• Sign On Message
• OEM Data (If available)

An example of the BIOS Features tab is shown as below:
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Fields
The BIOS Features fields are explained in the following table:

Field Description

BIOS Date This field displays the date when the AMIBIOS ROM file was 
built. The value in this field cannot be changed.

BIOS Name This field displays the name associated with the AMIBIOS ROM 
file. The value in this field cannot be changed.

Processor This field displays the number that is used to define the processor 
type. The value in this field cannot be changed.

Major Version
This field displays the main AMIBIOS revision number that is used 
with the AMIBIOS release. The value in this field cannot be 
changed.

ID String 1 This field displays the ID string that is associated with the 
AMIBIOS ROM file. The value in this field cannot be changed.

BIOS Size This field displays the actual size of the AMIBIOS ROM file. The 
value in this field cannot be changed.

BIOS Tag This field displays the eight-character tag that is associated with the 
AMIBIOS ROM file. The value in this field cannot be changed.

Minor Version This field displays the minor AMIBIOS revision number that is 
used with the AMIBIOS release. This field is editable.

CPU Microcode 
Update Patches

This field displays processor patches that are contained in the 
AMIBIOS ROM file. The values in this field cannot be changed.

Sign On Message
This field displays the AMIBIOS sign-on message that is displayed 
during POST. The AMIBIOS copyright string is not editable. 
Note : This field must not be more than 175 characters in length.

OEM Data

This field displays the OEM data that is provided by the 
AMIBIOS. This field is 62-bytes long and displayed in two modes 
(text and hexadecimal). This field is editable. 
Note : The OEM data area is supported on the AMIBIOS 8.00.08 
core and later releases.

Buttons
The BIOS Features button is explained in the following table:

Icon Description
This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

Using the BIOS Feature Tab
You can use the BIOS Feature tab by following steps:
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1. To modify any editable field, click on it and type in the new value.
2. To save the changes you have made to the AMIBIOS ROM file, click on the 

File menu bar and select Save menu item. You can also click icon on Toolbar 
to  save the changes you have made.
Note : You can click on the Undo button to restore the original setup settings 
before saving any new changes.

DMI Tables Tab
The DMI Tables tab allows you to view and modify AMIBIOS DMI Tables such as 
BIOS information, system information, baseboard and so on.
An example of the DMI Tables tab is shown as below:

Fields
The DMI Tables field are explained in the following table:

Field Description

Formatted area

This field displays the DMI Tables values (in hex). You can modify all 
DMI table values except the first two bytes. 
Note: The first two bytes of the DMI Tables are used to define the 
table type and size.

Test Strings This field displays the DMI Tables strings. You can modify these 
strings but you cannot change the number of strings.

Buttons
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The DMI Tables button is explained in the following table:
Icon Description

This button allows you to restore the original setup settings.
Note  : This  Undo  button  is  used  the  same  way  throughout  the 
AMIBCP program.

This button allows you to go to the previous DMI table in the table 
list.

This button allows you to go to the next DMI table in the table list.

Using the DMI Tables Tab

You can use the DMI Tables tab by following steps:
1. From the displayed DMI Tables list, select the table you want to view.
2. To edit the table, simply type in new values in the formatted or text strings 

areas.
3. To save the changes you have made to the AMIBIOS ROM file, click on the 

File menu bar and select Save menu item. You can also click icon on Toolbar 
to save the changes you have made.
Note : You can click on the Undo button to restore the original settings before 
saving any new changes.
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